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Retry Polling 
 
The Retry Polling program is installed with build V7.3.1.134 and higher. It allows for retries of failed Send 
Programs, Save Programs, and Report Items. The default location of the application is C:\PCPOLL 
SYSTEMS\V7. 
 
 

 
 
 
In general, the options for Polling Retries are setup in the Preferences area of V7 Polling. Then the 
necessary scripts should be created. When that is done, the retry program should be setup to activate in 
auto mode to retry failed events. 
 

1. From the main V7 Polling screen above, click on Preferences on the menu on the left side of the 
screen. 

2. Next, configure the calendar to auto poll. For more information on setting up the auto poll feature, 
see the Help files on Calendar or refer to the online documentation found on 
www.technology4retailers.com  
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3. On the Miscellaneous 1 tab, Retry options have been added to the bottom of the screen. Select 
one, two, or all three options: Track Failed Send Program Items, Track Failed Save Program 
Items, and Track Failed Report Items. 

4. In RetryPoll reports, sent items and saved items will be displayed on the grid based on filter 
settings and the settings in V7 Polling Preferences and RetryPoll can also be filtered to display 
the desired machine/stores and polling actions. 

5. Create new scripts and schedules or use previously created scripts & schedules. The Retry 
program does not track individually run events. Only scripted items are tracked. The scripted 
items can be run manually or via the calendar. To learn how to set up a script or schedule please 
read the Help Files topics: Scripts and Schedules or refer to the online documentation found on 
www.technology4retailers.com  

6. After the event or events have been run manually (or via the Calendar), open and run 
RetryPoll.exe which is located in C:\PCPOLL SYSTEMS\V7  

 

 
 

7. A shortcut can be placed on the user’s desktop to make it faster to find again. 
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8. The software will open. 
9. Setup the Filter options 
 

A. Starting date – Defaults to the current date minus 1 day. 
B. Ending date – Defaults to the current date. 
C. Action type – Pick from All Action Types, Send Program, Save Program, and Poll 

Reports. The software defaults to All Action Types. 
D. Poll Area – Select from All Areas, or one of Area 1 through Area 6, where it is valid. The 

default is All Areas. 
E. Poll Type – The user can pick either pick Any Report Type, X Reports or Z Reports. 

The default is Any Report Type and is valid only when reports are included in the action 
type. 

F. Machine ID – defaults to all machines unless Filter By Machine is checked and 
machines have been selected or Filter By Store has been checked. Filtering can only be 
done on Machine ID or Store ID, not both.  

 
 

 
 
 

G. To Filter by Machine ID, click on the box in front of Filter By Machine. The Machine 
Selection button with activate. Click the Machine Selection button. 
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H. Select the appropriate machines from the list and then click OK. Use the Select All 
button to select all machines in the list. 

 
 

 
 
 

I. To filter by Store ID rather than the Machine ID, click the box in front of Filter By Store to 
activate the Store Selection button. Click the Store Selection button. 

 
 

 
 
 

J.  Select the appropriate store or stores. Click .OK. 
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K. Reports – Displays a list of reports based on the selected machines or stores. To filter by 
reports, click on the box in front of Filter By Reports then click the Report Selection 
button. 

 
 

 
 
 

L. Select the appropriate reports and then click OK. 
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10. Manually retrying selected poll events is performed by selecting the desired events in the grid and 
clicking on Retry Selected Items button. Selecting items: 

a. To select one item in the grid, click on the specific item. As in the example above, the 
selected item will turn blue. 

 
 

 
 
 

b. To select multiple items press and hold the Control key (Ctrl) on the keyboard while 
clicking on the desired items. 
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c. All items in the grid above can be selected at one time by clicking on the asterisk (*) 
button. The asterisk is in the top left corner of the grid. See the red box. If there are 
already items selected, this action will clear the selected items and clicking the asterisk 
(*) button again will select all items in the grid. 

11. After the Retry Selected Items button is pressed, V7 Polling will open and a communications 
window will open showing the progress of the poll. 
 

 

Other Features 
 

 
 
 

1. Status field – The status field indicates the current status of a polling item listed in the grid. The 
different status conditions are: 

a. New – the item failed its normal polling attempt and has been added to the polling retry 
list. 

b. Retry Pending – the item has been sent to V7 Polling. 
c. Last Retry Failed – the last retry was not successful. 
d. Retry Successful – the last retry was successful. 
e. Max Retry Failure – when running in auto mode, Max Retry Failure indicates the item 

failed the maximum number of retries as set in File | Preferences | Auto Run. 
2. Retry Count –Indicates the number of times the item has been sent to polling to retry 

communications. 
3. Last Retry Poll Date – is the date/time the item was last sent to V7 Polling. 
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Before 1st attempt to re-poll 
 
 

4. Auto Mode – Polling Retry can run in auto mode by clicking on the Auto Mode button so that it 
says Auto Mode On. In this mode, items listed in the grid will automatically be sent to polling a 
maximum number times based on Preferences. Auto Mode may also be started by using a 
command line parameter ‘/AUTO_MODE’. This allows the program to be started in auto mode 
with Windows Task Scheduler or via a shortcut. 

5. Closing the software or turning off Auto Mode will stop the automatic retries.  
6. Retries can be run manually via the Retry Selected Items button. 

 
 

 
After the 1st attempt to re-poll 
 

7. After the first attempt, the Retry Count changes in the screen above. 
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After 2nd attempt to re-poll 
 

8. After the next attempt, the Status column shows the last six items have maxed out their retries, 
and are now shown in red. In the Retry Count column, it shows that there were three retries for 
these items. The top seven items in yellow can be retried without having to reset the selected 
items. They show two retry attempts. 

 
 

 
After 3rd attempt to re-poll 
 

9. The top seven items were retried but the screen above shows that they failed for the last time. 
The Retry Count column shows that all items have failed for the third time. When the number of 
attempts is maxed out, the Status column will be highlighted in red as above.  
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 Grid Toolbar 
 

 
 
 

10. Reset Selected Items – This button will reset the status of the selected items to ‘New’ so that, in 
Auto Mode’, they will be resent to V7 Polling. 

11. Refresh Display – This button updates the grid with items that have recently been added to the 
retry table from polling. This is done automatically based on settings in Preferences, but can also 
be done manually. 

12. Dismiss Selected Items – This button deletes all highlighted items from the grid. 
 
 

Preferences 
 

 
 
 
Preferences can be setup for the Retry Polling software from the File menu at the top of the screen by 
scrolling down to Preferences. 
 
 General tab 
 

 
 
 
The options of the General tab include: 

A. Leave Program Running - allows the program to keep running. When the program is in Auto 
mode, it will terminate when there are no items to retry based on the ‘Maximum No Activity Check 
Intervals” on the Auto Run tab. So if this field is set to 5 and the auto check interval runs 5 times 
without any items to send to polling, the program will terminate – unless ‘Leave Program Running’ 
is checked.  

B. Delete Old Items After (enter number of days) Days - deletes items after the number of days set 
by the user. For example if the number of days is set to “7,” the data will only be retained for 7 
days then will be deleted. 
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C. Delete Successful Items - deletes items that were successfully polled from the next attempt. 
 
 Auto Run tab 
 
 

 
 
 
The options on the Auto Run tab are Maximum Item Auto Retries, Table Refresh Rate (sec), 
Auto Check Interval (min), Maximum No Activity Check Intervals 
 
 EMail Options tab 
 
 

 
 
 
The Email Options tab allows the user to pick the email program to use to send an email with the results 
of the retry. Enter a CC (carbon copy) email address (optional) and a To address, and then click the Test 
Email button to check that the email will be sent to the recipient. 
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The screen above left will open only if Default Email Program is picked. Click the Allow button. If the 
email is successfully sent, the screen on the right will open. Click OK. 
 
 Auto Email Options tab 
 
 

 
 
 
Use the Auto Email Options tab to setup automatic emailing of the selected options. It allows the user to 
include specific stores, pick when to notify the store, let the store know what Item or Report or Z Report 
failed. It also allows the user to pick what to list on the report. 
 
 
When to Notify 
 

 
 
 
The When To Notify section of the screen defines when the auto email function will send emails 
regarding polling failures. 
 

A. Once Per Day Per Store At Specific Time – each store can specify a time that the retry 
program will email a failure notification. If, at the specified time, there are items that failed a 
maximum number of times the program will send an email failure notification. 

B. Once Per Day Per Store – if this item is selected the program will send an email failure 
notification when an item fails a maximum number of times. Only one email will be sent per 
day. 
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C. After Each Max Fail – an email will be sent for each item that fails a maximum number of 
times. If there are several items on the grid that have failed a maximum number of times, the 
program will send one email that will include those items. The program will continue to send 
email notifications. 

 

What to Notify For 
 

 
 
 
The What To Notify For section of the screen defines what type of poll items to send email notifications 
for. 

A. Any Failed Item – an email notification will be sent for any item that fails a maximum number 
of times. 

B. Any Failed Report – an email notification will be sent only for reports that fail a maximum 
number of times. 

C. Any Failed Z Report – an email notification will be sent only for Z reports that fail a 
maximum number of times. 

 
 
What to List 
 

 
 
 
The What To List section of the screen defines the information that will be sent in the email notification. 

A. Print/Preview Report – the email notification will be set up like the print/preview report. 
B. Item Failure Per Store – will contain the name of the item that failed and the store name that 

item came from. 
C. Action Type + Name Per Store/Machine – will contain whether the failure was a send, save 

or report and will include the name of the store. 
D. Details – allows for the selection of the following details to be included in the email 

notification:  Store Name, Machine ID, Action Type, Action Name, Report Type/Area, Poll 
Date/Time, Last Retry Date/Time, and Include Header Line. 

 
 
Delete Settings button - clears the settings picked. 
Save Settings button - saves the settings just setup. 
Copy To New Store button - copies the current settings to a new store. 
Cancel button - clears the settings and closes the screen. 
Close button - closes the screen. 
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Exit 
 

 
 
 
Exit on the File menu will close the Retry Polling software. 
 

Optimize Table 
 

 
 
 

The Optimize Table feature removes deleted items from the retry table, which reduces the table’s size. 
From the Tools menu, scroll down to Optimize Table. 
 
 

 
 
 
The PollRetry table cannot be optimized with the Auto Mode button set to On. The warning above will 
appear. Click OK. Click the Auto Mode button to Off and try again. 
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If V7 Polling is open, the message above will appear. Click OK, turn off V7 Polling, and try again. 
 
 

 
 
 
If the optimization is successful, the screen above will open. 
 
Setting up auto mode to run automatically 
 
Use the Windows Scheduled Tasks to open RetryPoll.exe at a set time in auto mode.  Or add the 
AUTO_MODE command to a shortcut icon.  The shortcut icon will need to be run manually, but will open 
the RetryPoll.exe in Auto Mode.  If the software opens in auto mode then it will automatically begin the 
retry process.  To open in auto mode, simply add the “ /AUTO_MODE” command to the end of the file 
path for either the shortcut or via a Scheduled Task.  Ex.  "C:\PCPOLL SYSTEMS\V7\RetryPoll.exe" 
/AUTO_MODE  (Note:  There is a space before the / ) 
 
Setup Options 
 
Under the File menu, there are Preferences. The software can be setup to retry events X number of 
times. The software will also auto close when there are no events to retry. Users can auto email failed 
listings. 
 
About 
 

 
 
 
To find the version number of the Polling Retry software scroll down from the Help menu at the top of the 
screen. 
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Tip: If a poll fails, the dealer could be notified via a free text message sent through email to their cell 
phone from the computer. The receiver will still pay for the incoming message but it will be free for the 
sender. A txt can be sent to the dealer’s cell phone by using their cell number to replace the 
“10digitphonenumber” portion of the email addresses for the cell phone services below: 
 
Verizon: 10digitphonenumber@vtext.com 
AT&T: 10digitphonenumber@txt.att.net 
Sprint: 10digitphonenumber@messaging.sprintpcs.com 
T-Mobile: 10digitphonenumber@tmomail.net 
Nextel: 10digitphonenumber@messaging.nextel.com 
Cingular: 10digitphonenumber@cingularme.com 
Virgin Mobile: 10digitphonenumber@vmobl.com 
Alltel: 10digitphonenumber@message.alltel.com 
CellularOne: 10digitphonenumber@mobile.celloneusa.com 
Omnipoint: 10digitphonenumber@omnipointpcs.com 
Qwest: 10digitphonenumber@qwestmp.com 
 
Information is from allthingsmarked.com. For more information see: 
http://allthingsmarked.com/2006/09/04/howto-send-free-text-messages-through-email/ 
 
 


